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I.  Abstract
In the Gulf Coast and Atlantic Seaboard regions, tropical storms and hurricanes consistently cause defoliation 
and deforestation among coastal forests each year. After a severe storm clears, there is an urgent need to assess 
the storm’s impacts on timber growth so state and/or national resources can be targeted to assist these impacted 
areas in recovery.  Additionally, it is important to identify these damaged areas since they have an increased 
probability of burns and a susceptibility to invasive species in the months and years following the storm. It is 
also vital to understand and manage the immediate and later effects on the carbon cycle in the coastal forest 
ecosystem. Introducing remotely-sensed data from NASA and NASA-partnered  Earth Observation Systems 
(EOS), this project seeks to improve the current methodology.  EOS to be utilized in this study include Ice, 
Cloud, and land Elevation (ICESat) and its Geoscience Laser Altimeter System (GLAS) instrument, Landsat 
TM,  and  the  Advanced  Wide  Field  Sensor  (AWiFS)  sensor  available  from  the  Indian  Remote  Sensing 
ResourceSat-1.  The primary focus for this project will be on the utilization of ICESat data products to detect 
forest canopy loss resulting from hurricane and tropical storms. By leveraging partnerships with such entities as 
the US Forest Service, the USDA Forest Inventory Analysis (FIA) Program, Mississippi Institute for Forest 
Inventory (MIFI), the Gulf of Mexico Alliance, and coastal counties and parishes of the study area, this project 
will determine an improved method of detecting and mapping hurricane-caused disturbances.

II.  Introduction

Tropical Storms and Hurricanes historically have had a dramatic effect on impacted areas, particularly 
the Gulf of Mexico region. This region is susceptible to hurricanes due to the geographic area in the Northern 
Gulf of Mexico. Hurricanes that enter the Gulf increase their strength with the warm water, and proceed to 
make landfall on the Gulf Coast.  The  2005 Atlantic hurricane season was the most active Atlantic hurricane 
season in recorded history. On August 23, 2005, Tropical Depression Twelve, later to be known as Hurricane 
Katrina, was becoming organized over the Central Bahamas. Katrina strengthened from a low-end Category 3 
hurricane to a Category 5 in less than 12 hours by August 28. Katrina headed for the Mississippi/Louisiana 
border, eventually making final landfall on August 29, 2005 at the mouth of the Pearl River, still as a Category 
3 hurricane with an estimated intensity of 105 knots. While Katrina’s strength quickly dissipated as it traveled 
across land, the impact was devastating for Louisiana and Mississippi. Hurricane Katrina was the most costly 
hurricane resulting in $81.2 billion in damage and was one of the five deadliest hurricanes to strike the United 
States (Johnson, 2006).

One of the economic areas devastated by Katrina hit was the timber industry for southeastern 
Louisiana and Coastal Mississippi.  Estimates indicate that Katrina caused 3 times the amount of damage that 
Ivan in 2004 caused, totaling over $1.3 billion (MISSISSIPPI INSTITUTE FOR FOREST INVENTORY, MIFI, 2006).  The 
timber industry in Mississippi contributes $11-14 million annually to the state’s income (MIFI, 2006).   Loss of 
pine forests can be extremely detrimental to the economy of South Mississippi, with approximately 54,000 jobs 
relying  directly  and  66,000  jobs  relying  indirectly  on  forestry  (MIFI,  2006).   Federal  land  management 
procedures  are  so  complex  that  they  prevent  timely  action  to  address  ecological  crises  on  public  lands 
(WWW.WHITEHOUSE.GOV, 2002). This project involves being able to estimate and assess forest damage quickly and 
by a more cost effective means that can save valuable resources and allow for an expedited recovery time.  

III. Study Area

This projects study area includes Saint Tammany and Washington parishes in Louisiana and Hancock 
and Pearl River counties in Mississippi (See Figure 1). Hurricane Katrina made landfall in Plaquemines parish, 
Louisiana, and the eye wall of the storm passed directly over Hancock and Pearl River counties, Mississippi 
(Glass and Oswalt, 2006). The study area encompasses approximately 802,400 Hectares of which over 288,000 
Hectares are pine forests and woody wetlands as of from the 2006 land classification performed as part of this 
study.  This area contained much of the coastal forest that was damaged by Katrina and will therefore yield 
areas containing timber damage.  
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Figure 1: Map of Study Area with ICEsat tracks

IV. Missions Utilized

A. Ice, Cloud and land Elevation Satellite (ICESat)

The ICESat mission was launched on January 12, 2003 from Vandenberg Air Force Base, California 
on a Boeing Delta II rocket. It travels nearly 17,000 miles per hour, sending short pulses of green and infrared 
light 40 times per second while collecting the reflected laser light in a 1 m telescope (NASA, 2007A). Each 
elliptical  footprint has an average diameter of 70 m, and the footprints are approximately 170 m apart The 
Geoscience Laser Altimeter System (GLAS) instrument has three lasers that each have a 1064 nm laser channel 
for surface altimetry and dense cloud heights and a 532 nm lidar channel for the vertical distribution of clouds 
and aerosols (ZWALLY, ET AL., 2003). Only one laser is operated at a time, with current operations including 33-56 
day campaigns several times a year. 

The ICESat data products utilized in this study were GLA01, GLA05, GLA06, and GLA14. Some of 
the lower-level products are used to generate higher-level products such as GLA 14, which was the only data set 
downloaded for this study. The GLA14 product is the global land surface altimetry data product that provides 
surface elevations for land. GLA14’s data also includes the laser footprint geo-location and reflectance as well 
as geodetic, instrument, and atmospheric corrections for range measurements (ZWALLY, ET AL., 2003).

ICESat  is  able  to  determine  land  surface  vertical  structure  within  laser  footprints  by  integrating 
topographic relief and vegetation using received waveforms recorded by the GLAS.  When incorporated with 
elevation products, the vegetation height can provide aboveground biomass estimations (Harding, 2005). Lidar 
has the unique capability for the estimation of forest canopy height and biomass derivations with ICESat being 
the first satellite to make vertical measurements of the Earth by use of an onboard light source (LEFSKY ET AL., 
2005 & SCIENCEDAILY, 2003).
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ICESat products and tools were downloaded from the National Snow and Ice Data Center’s (NSIDC) 
website  using  the  Warehouse  Inventory  Search  Tool  (WIST,  http://nsidc.org/data/icesat/order.html).  The 
ICESat data included GLAS/ICESat Land products, specifically the L2 Global Land Surface Altimetry Data 
(product  14,  release  28  GLA14).   The  tools  downloaded  from  the  NSIDC  website 
(http://nsidc.org/data/icesat/tools.html) were the NSIDC GLAS Altimetry Elevation Extraction Tool and the 
Interactive Data Language (IDL) Reader tool, both of which are necessary to use ICESat data. 

ICESat  transects  selected  from the NSIDC data warehouse  were  located  within the predetermined 
study  area  and  were  based  upon  availability  of  data  before  and  after  Hurricane  Katrina  made  landfall  in 
Mississippi on August 29, 2005 (Table 1)

Table 1. ICESat acquisition dates over the study area.   

B. Landsat  5 TM

Landsat 5 maintains an eight day repeat coverage orbit between the two 16 day revisitation period 
individually, collecting imagery from a 705 km altitude (USGS, 2007A). With the consistent nature of the data, 
Landsat  is  the  instrument  of  choice  for  change  detections.  Landsat  imagery  was  used  to  visualize  land 
classifications and land uses in the study area.  

. 

V. Data Processing

A.     ICESat to GIS Points

For geospatial use of ICESat GLAS data, the raw binary data product of GLA14 was first extracted 
with the NSIDC elevation extractor tool, also known as the NSIDC GLAS Altimetry Elevation Extraction Tool. 
The extraction tool is an IDL computer script that runs from a setup file which accepts user-provided input and 
output data sources (raw binary data products) along with the type and version of the data. It then converts the 
binary data into rows and columns of useable data. Once in the new format, the data was able to be brought into 
ESRI ArcGIS and overlaid onto the Landsat 5 classification of the study region. 

B.  Time Conversions to J2000

All ICESat data is reliant on time due to the fact that it is temporally referenced from the laser burst 
emitting from ICESat and the returning responses. The time format that is used is J2000, which counts seconds 
from noon on January 1st, 2000. To determine the data needed for analysis, a start and stop time in the J2000 
format must be provided for each transect. Start and stop times were obtained by querying the start and stop 
points of each transect in ArcGIS. The data for start and stop times was input to an Excel spreadsheet, and once 
this was done, J2000 and Delta times (number of seconds) were calculated.  

C.   ICESat GLA14 to ASCII format

Using start time and delta time, ICESat GLA14 data was run through the IDL Reader tool to convert it 
to ASCII format. ASCII-formatted data is necessary for processing by the MATLAB script.  

D.  MATLAB processing 
Each ASCII-formatted data set was run through a user created MATLAB parsing script 

to generate the spreadsheets containing waveform data and to plot waveforms in graphical format.  An example 
GLAS waveform return is shown in Figure 2. The x-axis displays the energy of the laser pulse transmitted back 
to the receiver and the y-axis displays the calculated height of the laser pulse as it hits a surface. Looking from 
top to bottom, the smaller curve indicates the canopy height (meters) and the “spike” curve shows the ground 
surface elevation (meters). The waveform plot was generated using the user created  MATLAB parsing script. 
The MATLAB script mathematically detects peaks within the waveform data to separate the ground surface 

Louisiana Transect Mississippi Transect
October 30, 2004 October 4, 2004
November 16, 2005 October 22, 2005

4

http://nsidc.org/data/icesat/tools.html
http://nsidc.org/data/icesat/order.html


layer from the canopy level. This is accomplished by calculating slopes within the data distribution. A value of 
0 slope indicates a local maxima, either surface or canopy elevation. To distinguish between surface and canopy 
elevations, the script locates the positive to negative slope crossover point within the data. 

Figure 2: Example GLAS Waveform Return Plot
E.   Data set Co-Location
The waveform spreadsheet data was displayed in GIS and points that were parallel to one another were selected 
from each transect. This ensured that co-located ICESat points were used for further data processing. The same 
number of points were present in each matching seasonal transect during this step.  

F.  Digital Elevation Model (DEM) Grid Points – Interpolation of National Geodetic Survey Geoidal 
Separations

The geoid separation is the distance between the geoid and the ellipsoid. ICESat measures height against the 
ellipsoid, which is the perfect geometrical shape that is mathematically fit to the earth. However, the USGS 
Digital Elevation Model (DEM) is referenced to the geoid. One way of checking the data for accuracy is to 
verify that the geoid separation in coastal areas is negative because in these locations, the ellipsoid is underneath 
the geoid.  It  was necessary to have outputs referenced against the ellipsoid for them to be compatible with 
ICESat. 

The  approach  taken  was  to  combine  elevation  values  from the  USGS geoid  elevation  and  the  separation, 
resulting in heights referenced to the ellipsoid. Geoid separations were obtained from the National Geodetic 
Survey’s (NGS) website (http://www.ngs.noaa.gov/) using a text file of point data with specific latitude and 
longitude values  as  input data.  A grid  of points was pre-created in Microsoft  Excel  and then displayed  in 
ArcGIS for adjustment. Once a grid with acceptable dimensions was created, the text file of point data was 
input to the NGS website and geoid separation values returned were updated in the Microsoft Excel table of grid 
points. This table of grid points was then used to generate a raster grid of geoid separation in ArcGIS with the 
Spatial Analyst toolbar and inverse distance weighted interpolation method. Using ArcGIS raster calculator, the 
geoid elevation was added to the separation values which resulted in a new DEM referenced to the ellipsoid. 
After this addition, it became possible to overlay the ICESat transect points and obtain elevation values beneath 
them because the ICESat  data was compared to the ellipsoidal  elevation. Elevation values  beneath ICESat 
points were acquired using GRIDSPOT, a script that assigns raster cell values to the point features at the same 
location (http://arcscripts.esri.com/details.asp?dbid=12773). 
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Technical  Steps  for  Creating a  New DEM of Ellipsoidal  Elevation using the Spatial  Analyst  extension of 
ArcMap: 

1. Spatial Analyst → Options → Extent tab → set to the original DEM, referenced to the geoid
2. Spatial Analyst → Options → Cell Size tab → set to the original DEM 
3. Spatial Analyst → Interpolate to Raster → IDW

a. Feed with inputs layer
b. Identify the table field where the geoid separation layer is located
c. Select a location for output

4. Spatial Analyst → Raster Calculator
a. Original DEM layer + separation raster = New DEM of ellipsoidal elevation

G. Elevation Beneath ICESat Transect Points
Before elevations beneath ICESat transect points could be obtained, the new DEM of was projected to NAD 
1983  UTM  Zone  15N,  along  with  the  ICESat  transect  points.  The  GRIDSPOT  tool 
(http://arcscripts.esri.com/details.asp?dbid=12773) was then used to extract the elevation values from the DEM 
and copy them to each transect’s attribute table. Attribute tables were exported as DBASE IV files and saved in 
Microsoft Excel format for the next calculations of USGS height, changes in canopy height between dates, and 
statistics.

H. Canopy Change Calculations
The USGS height values were calculated with data from the Microsoft Excel files 
using the following equation where:

HGT_USGS = New local USGS elevation referenced to ICESat data
LOCAL_MAXIMA = GLAS Canopy height return from MATLAB script
DEM_ELEV = SRTM DEM elevation
DEM_USGS = USGS DEM elevation

HGT_USGS = LOCAL_MAXIMA + (DEM_ELEV – DEM_USGS)
   

Final  differences  in  canopy  height  were  calculated  for  each  point  by  subtracting  the  pre-Katrina 
dataset’s new USGS elevation from the post-Katrina dataset’s new USGS elevation. Following this, the points 
were displayed in ArcGIS and spatial analysis was done to determine useful ICESat points. Some points were 
located on the border of Hancock and Pearl River counties in Mississippi. These points were excluded and the 
remaining points were divided by county. Data statistical classifications were then examined for each point set. 
The data contained several  positive outliers. Therefore the final  dataset  only included data within +/- three 
standard deviations. Values of the threshold between the third and fourth standard deviations were recorded and 
a query was performed in ArcGIS to remove the fourth standard deviation data. Mean, median, range,  and 
standard deviation for this data were calculated. The median value was used as the indicator of canopy height 
change because it is the least influenced by outlier data.   
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VI. Results

Canopy height change results from Figure 3 indicate that the median is a better indicator of height 
change than the average. Hancock County underwent a median canopy height change of approximately -0.25 
meters. The other three counties experienced a positive median canopy height change of less than 1 meter. It  
should be noted that the results in Figure 3 show median canopy height change compared to average canopy 
height change after statistical outliers were removed. Only data within three standard deviations was included. 

Canopy Height Change by County

-0.50 -0.25 0.00 0.25 0.50 0.75 1.00 1.25 1.50 1.75 2.00 2.25 2.50

St. Tammany
Parish

Washington
Parish

Hancock County

Pearl River
County

Canopy Height Change (m)

Median

Average

Figure 3: Canopy Height Change Results
VII. Discussion 

A. Results Discussion 
Hancock County was the only county that experienced a median canopy height loss from dates 

before Katrina to after Katrina. The median canopy height loss for Hancock County was approximately 0.25 
meters.  All  other  counties experienced  gains  in canopy height  (Pearl  River County:  less than 0.25 meters; 
Washington and St.  Tammany Parishes:  between  0.25 and 0.50 meters).  These are  not  the results  that  we 
expected but there are some important considerations. 

Results from a DEVELOP previous study done in 2007,  showed that when ICESat transects were 
divided into small group sections and average canopy height change values were obtained for each section, 
most sections experienced a loss in canopy height of up to 7 meters. Data for this study was enumerated at the 
county level.  Differences  in  the canopy height  change  values  may exist  for  each  data  set  due to  dates  of 
acquisition and division of data into sections versus counties. Although, the number of points for each county 
varied, there was enough data present to conduct the study. 

This study’s results included ICESat data that was acquired over a number of different  land cover 
types. Future studies that extract ICESat data from only forest cover types may yield more expected results. 
Some of  the  larger  positive  statistical  outliers  present  in  the  results  could  be  due  to  a  number  of  factors 
including construction following the hurricane. This would result in a positive change in height associated with 
urban land cover. 

The  removal  of  statistical  outliers  is  being reconsidered  to  include only data  within two standard 
deviations as compared to the current three standard deviation limit. This should exclude many of the large 
positive outliers that are influencing the data, but is not expected to have as much of a limiting effect on the 
forest land cover types. The reason for this is that the median canopy height change as opposed to the mean is  
being used, due to it being less influenced by statistical outliers. This was an important finding of the study and 
the median appears to be a better statistical measure than the mean. 
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It is possible to calculate canopy height using several different measures. Future studies may compare 
the three different measures of canopy height that are available. These are the local maxima, height under 75% 
of the area of the data curve, and height using the centroid. The study from the fall term looked at where 75% of 
the integrated curve fell as an indicator of canopy height. This approach looked for the positive to negative 
slope conversion point as an indicator of local maxima, and further determining which of these is canopy or 
ground  height.  Heights  will  be  calculated  using  the  centroid  for  comparison  between  the  three  different 
measures of canopy height. The comparison can be used to identify differences from the three methodologies. 

B. ICESat Limitations

While ICESat has many unique characteristics and has made an immense contribution to the world of 
remotely sensed data, it also has many limitations when attempting to conduct a study such as this. Previous 
studies utilizing ICESat data to detect canopy heights have done so over continuous tracts of northern latitude 
boreal forests or tropical rainforests. The advantage of these locations is that forest land cover is not mixed as 
much with other land cover types that can complicate interpretation of GLAS returns. This study has shown that 
when filtering GLAS data, researchers should ensure that GLAS returns have been obtained over continuous 
forest land cover. The canopy height change results from this study contain GLAS returns from a number of 
different land cover types.  

The ICESat data is referenced to the Shuttle Radar Topography Mission’s (SRTM) elevation data, a 
coarse elevation data set with spatial resolutions between 30 to 90 meters. This project required the use of local 
elevation  data  to  obtain  more  accurate  estimates  of  canopy height  change.  This  study  used  USGS digital 
elevation model with 10-meter spatial resolution, and it did show improvements compared to the SRTM data. 
Additional steps were necessary to fit the geoid of the elevation data to the ellipsoid that the ICESat data and 
further complicated data processing. The creation of an Arc script tool designed for ESRI software would help 
to organize and speed up this process.  Such a tool  would create  a custom grid of points for interpolation, 
execute the interpolation process and geoid fit, overlay the ICESat transects, obtain the elevation at each ICESat 
data point, and export the data to a spreadsheet for further processing. ArcGIS has a simple-to-use interface for 
all of its script tool processes and is less complicated than IDL and other script tools that lack a visual interface. 

Another complication of using ICESat data relates to the continuity of ICESat transects. Of the ICESat 
transects obtained from the NSIDC only three were continuous. The track from October 4, 2004 contains a 
discontinuous transect of data. Furthermore, GLAS laser pulses are scattered by cloud cover. Therefore, GLAS 
footprints  that  have been influenced  by cloud cover  must  be filtered out  of the data set.  The user  created 
MATLAB parsing script was able to perform this function. It is a necessary step but results in some of the data 
being removed. Additional data is removed by ensuring that data points along tracks are collocated.  

The unexpected failure of ICESat GLAS Laser 1 in March of 2003, after only 36 days of data, spurred 
the use of Laser 2 on September 29, 2003. That laser continued intermittent work until June 21, 2004. Laser 3 
was then put into commission on October 3, 2004 and has been in use since. Due to the limited life of the laser, 
it only sporadically collects data, with the most recent collection session having taken place for 34 days from 
March 12th to April 14th, 2007 (NASA, 2007B). ICESat’s revisit period of 183 days to pass over the same path 
makes it very complicated to use in change detections. Crossing over the same route only every six months, 
chance dictates whether or not the laser will be on and comparisons can occur. This is further troubled by the 
fact that the 70 m footprints are not necessarily taken at the exact same location passed over before, or even 
along the same transect. Often, subsequent transects of data recorded by ICESat six months to one year after a 
transect has been recorded are spaced apart. ICESat’s 70 m elliptical footprints are also approximately 170 m 
apart along the same transect, giving only a partial view of forest characteristics and not a continuous one. Data 
collected over areas with uneven terrain introduce complications, such that the canopy and ground reflections 
are mixed together and thus hard to interpret (HARDING, 2005). 

Another finding of this project was that ICESat data obtained during matching seasons must be used. 
For example, if data from October was used, data from a date as close to that same date in October following 
one year after should also be used. This ensures consistency among data sets from one year to another and limits 
seasonal  differences  present  in the data.  It  was discovered  that  maintaining seasonality among data sets is 
difficult due to inconsistencies in ICESat data collection. Such inconsistencies result from complications such 
as laser failure.   

The  complexity  of  ICESat  data  causes  the  need  for  conversions  for  any  kind  of  analysis  or  use. 
Conversions from the raw binary data to ASCII format proved more complicated than originally thought due to 
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the necessary use of IDL programs available from the NSIDC website (NSIDC, 2007). The IDL reader program 
was not user-friendly. The format for certain inputs were unclear and time consuming. For example, the start 
time needed to be in Julian time in seconds from the arbitrary date of January 1st, 2000 at noon. The elevation 
extractor tool was slightly easier to use but still required much trial and error. Future work should consider the 
development of a small set of user-friendly tools to expedite the data conversion process. 

VIII. Conclusions

Besides the intended purpose of measuring changes in ice and snow cover, ICESat can be applied to 
other land cover types. The GLAS waveform allows for the identification of canopy and ground elevations. 
Using co-located ICESat transects, it is possible to perform a change analysis and analyze the effects of a major 
event like a Hurricane on forests. Hurricane Katrina had a major impact on Mississippi and Louisiana forests, 
and the use of satellite technology may be an improved method on quantifying forest  change. This project 
demonstrates the capabilities of such technology and identifies where improves can be made. 
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